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Preface
Intended use statement

The device is intended to be used as a front end Nicolet EEGwireless32/64 
amplifier with the Nicolet Neurodiagnostic system to record, measure, store, 
analyze and display cerebral and extracerebral physiologic data for EEG and 
Sleep studies with or without synchronous digital video. This data includes but is 
not limited to EEG, EOG, EMG, ECG, respiration, body position, snore, heart 
rate, oxygen saturation and other physiologic signals. All ages of patients are 
served, including infants either within a medical facility or outside a medical 
facility. It is intended for use only under the supervision of medically trained and 
qualified professionals who will use all available information to aid in the 
diagnosis of Sleep, Epilepsy and other related disorders. While the Nicolet 
Neurodiagnostic systems are capable of displaying signals, such as Sp02 and 
ECG, the system is NOT intended for monitoring such signals for the 
preservation of life.
April 27, 2015 a



Nicolet Systems
Copyright

This manual contains proprietary information, which is protected by copyright 
and may not be copied in whole or in part except with the prior written 
permission of Natus Neurology Incorporated. The copyright and the foregoing 
restrictions on the copyright use extend to all media in which this information is 
preserved.

This copy of the User Manual shall be used only in accordance with the 
conditions of sale of Natus Neurology Incorporated or its distributors.

Natus Neurology Incorporated makes no representations or warranties of any 
kind whatsoever with respect to this document. Natus Neurology Incorporated 
disclaims all liabilities for loss or damage arising out of the possession, sale, or 
use of this document.

www.natus.com

Natus Neurology Incorporated
3150 Pleasant View Road
Middleton, WI 53562-3530
USA

About the Nicolet brand system

The range of Multimedia EEG Nicolet brand systems have been designed and 
manufactured by Natus Neurology Incorporated, which has always had an 
enviable reputation for innovation and quality of its products.

CE Mark

Compliant to Medical Device Directive 93/42/EEC
b April 27, 2015



Preface
Declaration of Conformity 

R & TTE Directive - Radio and Telecommunications Terminal Equipment

Hereby, Natus Neurology Incorporated declares that the Nicolet EEGwireless32/
64 amplifier, it’s derivatives, and its accessories are in compliance with the 
essential requirements and the other relevant provisions of Directive 1999/5/EC.

[The following signed (and translated) declaration of conformity]:

We, Natus Neurology Incorporated, at 3150 Pleasant View Road, Middleton, WI, 
USA, declare under our own responsibility that the Nicolet EEGwireless32/64 
amplifier to which this declaration refers conforms with the relevant standards or 
other standardizing documents of EN 50371:2002 according to regulations in 
Directive 1999/5/EC. 

Dan Lombardi, 11 Oct 2010

Director of Hardware Development and Intellectual Property

Middleton, WI USA 53562
April 27, 2015 c
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FCC wireless compliance

FCC Identifier:

Name of Grantee:

Equipment Class:

FCC Rule Parts:

XGU-515-015X00A

Natus Neurology Incorporated 

Digital transmission system 

15C

Frequency Range (MHz): 2412.0 - 2462.0 

Transmission Power Levels:

NOTE: The Nicolet EEGwireless32/64 amplifier is approved for body worn 
application. With transmitter enabled, the maximum spatial peak SAR 
(Specific Absorption Rate) valueis 0.0154 W/kg.

This hardware uses the FreeRTOS operating system. Go to www.freertos.org for 
more information.

THIS DEVICE COMPLIES WITH PART 15 OF THE FCC RULES. OPERATION IS 
SUBJECT TO THE FOLLOWING TWO CONDITIONS: (1) THIS DEVICE MAY NOT 
CAUSE HARMFUL INTERFERENCE, AND (2) THIS DEVICE MUST ACCEPT ANY 
INTERFERENCE RECEIVED, INCLUDING INTERFERENCE THAT MAY CAUSE 
UNDESIRED OPERATION.

THE MANUFACTURER IS NOT RESPONSIBLE FOR ANY RADIO OR TV 
INTERFERENCE CAUSED BY UNAUTHORIZED MODIFICATIONS TO THIS 
EQUIPMENT. SUCH MODIFICATIONS COULD VOID THE USER’S AUTHORITY TO
OPERATE THE EQUIPMENT
d April 27, 2015



Preface
Safety summary

In this manual, two labels identify potentially dangerous or destructive 
conditions and procedures:

The WARNING label identifies conditions or practices that may present danger 
to the patient and/or user.

The CAUTION label identifies conditions or practices that could result in 
damage to the equipment.

NOTE: Notes help you identify areas of possible confusion and avoid potential 
problems during system operation. 

Do NOT use cables with unattended and unsupervised children.

Do NOT wrap cables around your neck. 

Keep batteries away from children.

Conductive parts or electrodes and their connectors, including the neutral 
electrode for type BF or cf electroencephalographs are not to contact other 
conductive parts and earth ground.

Do NOT use outside of the published specification ranges. Use of device 
outside of the specified ranges may result in inaccurate results.

Do not wrap the Nicolet EEGwireless amplifier in blankets or place under 
pillows during use.
April 27, 2015 e



Nicolet Systems
Use with other equipment

Defibrillators and High Frequency surgical equipment

The amplifier is not defibrillator proof. The system must be 
disconnected from the patient prior to defibrillation.

MRI equipment

The Nicolet EEGwireless32/64 amplifier or patient electrodes 
are not to be worn by a patient during an MRI study.

Other patient-connected equipment

When used simultaneously with other patient-connected 
equipment, for example, a cardiac pacemaker or other electrical stimulator, 
it is unlikely that a safety hazard will arise. However, always consult the 
documentation supplied with the other patient-connected equipment to 
ensure all hazards, warnings and cautions are considered before the 
equipment is used with the amplifier.

It should be noted that other electrical stimulators can cause noise in the 
EEG data.
f April 27, 2015



Preface
Read the Safety Reference guide

Please read the Additional Information and Safety Notes for Assorted Nicolet 
Brand Products Reference Guide 269-594705 on CD part number 482-638702 
thoroughly, paying special attention to the Safety information before applying 
power to and using your Nicolet Brand system.

Fixed installation guide

Please see the Fixed Installation guide Section 3 - 269-620300 and Section 5 - 
269-620500 for installation information.

IT requirements

Please see the Site IT Requirements document 269-644000 for information on 
wired and wireless networking specifications for operation of the Nicolet 
EEGwireless32/64 amplifier.
April 27, 2015 g
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Specification sheet

Please see Specification sheet 169-438800 for information regarding technical 
specifications of the EEGwireless32/64 amplifier.

Inspecting the system

Routinely check the instrument for exterior damage. 

Follow your medical facilities safety guidelines.

Recycling / disposal

Many local laws and regulations consider electric equipment-related waste 
as hazardous or requiring special procedures to recycle or dispose of. This 
includes batteries, printed circuit boards, electronic components, wiring and 
other elements of electronic devices. Follow all of your respective local laws 
and regulations for the proper disposal of batteries and any other parts of 
your system, such as monitors, amplifiers, keyboards, electrodes, etc.D

Refer to the natus.com website for recommended instructions and addresses 
for proper return or disposal of electronic wastes relating to Natus 
Neurology Incorporated products in Europe and other localities.

The contact information for the Waste Electrical and Electronic 
Equipment (WEEE) - In Europe

European authority representative

Natus Europe GmbH
Robert-Koch-Str. 1
82152 Planegg
Germany
h April 27, 2015
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European Authorized Representative

Natus Europe GmbH
Robert-Koch-Str. 1
82152 Planegg
Germany

CE Mark

Compliant to Medical Device Directive 93/42/EEC

Technical support

Domestic International
Natus Neurology Incorporated
3150 Pleasant View Road
Middleton, WI USA 53562 
1-800-356-0007
madison.helpdesk@natus.com
www.Natus.com

Natus Neurology Incorporated
Phone:  0049 (0) 180 501 5544
Fax:  0049 (0) 89 83942777
service.europe@natus.com
www.Natus.com
April 27, 2015 i
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Labels and symbols

The following labels and symbols may be affixed to the Nicolet EEGwireless32/64 
system:

When applied on device: Attention: Consult Accompanying Docu-
mentation. (ISO 7000-0434A)
When used in documentation: Caution, Warning or Precaution fol-
lows.

Consult Operating Instructions. Failure to follow operating instructions 
could place the patient or operator at risk. Image on blue background. 
(ISO 7010 M002)

Consult Operating Instructions. (ISO 7000-1641)

European Authorized Representative.

Manufacturer.
Natus Neurology Incorporated 
3150 Pleasant View Road 
Middleton, WI USA 53562
608-829-8500 
1 800-356-0007 
Fax: 608-829-8589 
www.natus.com 

Disposal at end of operating life instructions.

CE Mark and Notified Body. 

(Compliant to Medical Device Directive 93/42/EEC)

Type BF equipment.

RX Only CAUTION: USA Federal law restricts this device to sale or on the 
order of a licensed medical practitioner.
j April 27, 2015
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1 Introduction
This guide describes how to operate the Nicolet EEGwireless32/64 amplifier in 
conjunction with the Nicolet EEG system and software.
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Introduction
About the Nicolet EEGwireless32/64 amplifier unit

The Nicolet EEGwireless32 and Nicolet EEGwireless64 amplifiers are unique 
amplifiers and are referred to as Nicolet EEGwireless32/64 amplifier in this manual.

The Nicolet EEGwireless32/64 amplifier is a 32/64 channel EEG amplifier that 
connects to a Nicolet Brand system via wireless transmission or a standard network 
port. The Nicolet EEGwireless32/64 amplifier can be used in a hospital setting 
without the addition of custom network infrastructure.

The Nicolet 
EEGwireless32/64 
amplifier

• captures all signals needed to perform LTM monitoring, EEG, Sleep studies, 
research, Ambulatory and ICU monitoring. 

• provides low signal amplification (alternating current ‘AC’ recording) of 
physiological signals, and is designed specifically to amplify EEG and intracranial 
EEG signals.

• provides wired Ethernet or wireless Ethernet transmission of digitized signals, 
which interfaces to a Nicolet Acquisition system.

• provides a Stand Alone Mode feature for urgent recording situations.
• provides user selectable parameters including sampling rates and filters.
• includes built in SpO2, patient event button, and provides referential, bipolar 

recording.
• the amplifier is compact and lightweight with a custom garment wearable by the 

patient.

Operating system The Nicolet EEGwireless32/64 amplifier uses FreeRTOS™ as its operating system. 
For FreeRTOS™ licensing details, please visit www.freertos.org/a00114.html.

FreeRTOS™ is a trademark of Real Time Engineers Ltd.
April 27, 2015 1-3
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Power source The Nicolet EEGwireless32/64 amplifier can derive its power from either an AC 
outlet through the medical grade power supply, from one or two external battery 
packs, or in the case of a fixed installation, wallplate power.

The Nicolet EEGwireless32/64 amplifier has a second power port, which allows the 
addition of a second battery pack for longer recording time or a medical grade power 
supply. If the medical grade power supply is plugged in while a battery is also 
plugged in, the battery pack will charge.

There is an internal battery in the Nicolet EEGwireless32/64 amplifier that allows 
switching the external battery pack while in the middle of a study. When the external 
battery pack requires changing, it can be removed without interfering with the study 
as long as it is replaced within 10 minutes of removal.

If an external battery or AC power is connected to the Nicolet EEGwireless32/64 
amplifier, the internal battery will be charged.

Communication EEG data can be transmitted to the Nicolet acquisition system either by an Ethernet 
cable or wirelessly using a recommended 802.11 b/g access point. The Nicolet 
EEGwireless32/64 amplifier is IP addressable and can connect directly to a hospital 
network or private LAN.

Memory card The Nicolet EEGwireless32/64 amplifier also provides onboard storage of EEG. The 
Nicolet EEGwireless32/64 amplifier has an onboard memory card used to record 
data. When the memory card reaches within 10 minutes of its capacity, the Nicolet 
EEGwireless32/64 amplifier produces an audible alert.

Sampling rate The Nicolet EEGwireless32/64 amplifier provides selectable sampling rates from 128 
Hz - 12000 Hz.

When operating at 12 kHz Sample Rate, ensure the electrode lead cover is connected. 
Also, do not wrap the Nicolet EEGwireless32/64 amplifier in a blanket or place under 
a pillow.
1-4  April 27, 2015



Introduction
Nicolet EEGwireless32/64 amplifier symbols and components

AAZ

T U

V W X Y

Nicolet  wirelessEEG32A

M

N O P SRQ

B

E FD

K

HС

A

G I

J L

AB AC

Top Bottom Front Back

NOTE: External power from Inputs F and I are interchangeable between two external batteries and a medical power supply.

Symbol Description Symbol Description Symbol Description

A - Amplifier K Refer to page j in this manual. U - Electrode inputs (each side)

B Diagnostic port L - Disconnect headbox latch V Power on/off button

C Electrostatic sensitive M - Electrode leads cover W LED - Wireless transmission on

D Network port N SpO2 X Start recording button

E - LED - Ethernet connectivity O Electrostatic sensitive Y Stop recording button

F Power input for external batteries 
or power supply

P Event button input Z Impedance check button

G - LED - Power connectivity Q Type BF equipment AA LEDs - Impedance range

H - LED - Power connectivity R Trigger output (for Photic, etc.) AB - Battery door, under headbox

I Power input for external batteries 
or power supply

S Trigger input AC - LEDs - Impedance check

J - 32 or 64 headbox T Refer to page j in this manual.
April 27, 2015 1-5
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Activate the internal batteries

1. The first time the Nicolet EEGwireless32/64 amplifier is used, you must pull the 
two plastic strips out from the battery compartment (Figure 1) to activate the 
internal batteries for use with the Nicolet EEGwireless32/64 amplifier.

Pull the plastic strip labeled 1 first and then pull the plastic 

strip labeled 2 second to guard against damaging the amplifier.

 Figure 1

NOTE: The batteries arrive at 40%.

Contact Natus Neurology Incorporated customer service if you 
believe your amplifier’s internal batteries need to be replaced.

If the amplifier is going to be stored for extended periods of time (>2 
weeks) after pulling the plastic strips, it is recommended to connect the amplifier 
to an AC power brick or an external battery pack so that the amplifier can be 
used immediately when needed. If the amplifier will be stored on a cart that is 
not powered, the amplifier needs to be connected to an external battery pack 
during storage.

Do not transfer your amplifier’s internal batteries to another 
amplifier.

Nicolet  EEGwireless32A

1

1

2
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Introduction
Removing the electrode leads plastic cover

1. Grasp the plastic cover on both sides with one hand.
2. Grasp the Nicolet EEGwireless32/64 amplifier with the other hand.
3. Carefully slide the plastic cover off the Nicolet EEGwireless32/64 amplifier 

(Figure 2).

 Figure 2

Nicolet  wirelessEEG32A
April 27, 2015 1-7
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Separating the headbox from the Nicolet EEGwireless32/64 amplifier

1. Press downward on the release latch (Figure 1).

2. While firmly holding the Nicolet EEGwireless32/64 amplifier and headbox, pull 
the headbox towards yourself.

3. Carefully lift off the Nicolet EEGwireless32/64 amplifier from the headbox.

 Figure 1

Headbox interchangeability
You cannot use a 64 channel headbox with a 32 channel amplifier, but you can use a 
32 channel headbox with a 64 channel amplifier. 

NOTE: Montage setups between 32 channel configurations and 64 channel 
configurations are not interchangeable.

1

2

Nicolet  wirelessEEG32A
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Introduction
Electrode labels

The electrode label has an area for writing customized electrode nomenclature. For 
temporary markings, use an erasable dry marker. Use Isopropyl Alcohol to remove 
the temporary markings from the labels.

 Figure 1: 32 channel electrode label.

 Figure 2: 64 channel electrode label.

NOTE: The two grounds are linked together in the Nicolet EEGwireless32/64 
amplifier. You do not need to provide two grounds, but they are available for 
redundancy. The auxiliary reference is currently disabled, but will be functional in 
future releases.

Headbox dry erase 
label information

•Apply the label to the back of the Headbox.
•The overlay is removable and reusable.
•Use only dry erase markers & cleaners on overlay.
•DO NOT use permanent markers.
April 27, 2015 1-9
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Inspecting the system
Routinely check the system for exterior damage. Periodically check the system 
ground integrity, the system leakage current and the leakage current of the Nicolet 
EEGwireless32/64 amplifier and accessories.

Cleaning instructions
We recommend that you consult with your hospital infection control department and 
follow all appropriate policies.  Routine equipment cleaning recommendations are 
provided below.

Cleaning the Nicolet 
EEGwireless32/64 
amplifier

The Nicolet EEGwireless32/64 amplifier and accessories are classified as a 
noncritical item for infection control purposes. 

Do not use propanone (acetone) on any part of the equipment. No part of the system 
may be autoclaved or sterilized by any means. According to the CDC, the proper 
cleaning method for non-critical medical devices includes the following: 

• A456-N 

• A428-N 

• Cavacide 

• 3MQuat 

• 70% isopropyl alcohol.
1-10  April 27, 2015



Introduction
Cleaning the system Turn OFF the system power before cleaning the instrument. Do not permit solutions 
or cleaning agents to seep into the electronic portions of the system. Take special care 
around controls, connectors and panel edges. Do not use any abrasive cleaners. 
Remove any dust from the exterior of the system with a soft brush or clean cloth. Use 
a brush to dislodge any dirt on or around the connectors and panel edges. Remove 
stubborn dirt with a clean soft cloth slightly dampened with a mild detergent (soap)  
or low level disinfectant detergent solution.  Allow the items to air dry before next 
use. 

Use of detergent-disinfectants on skin may cause adverse reactions; therefore, gloves 
are recommended when cleaning with these products.

Cleaning the monitor 
screen

When the monitor is on, the screen has a slight static charge, which attracts dust. To 
remove any dust accumulation, wipe the display screen with a soft brush or lint-free 
cloth. You may use an antistatic spray on the screen to reduce static buildup.
April 27, 2015 1-11



Nicolet Systems
Cleaning the 
keyboard

Disinfect computer keyboards daily, when visibly soiled, or when they become 
contaminated with blood. Quaternary ammonium-containing disinfectants may be 
used on keyboard (Rutala et al. 2006). 

Before using the disinfecting agent, perform a test on only one key 
or on an old keyboard to guard against possible bleaching or discoloration of the 
keys. 

If a keyboard cover is used, Rutala et al. (2006) recommends it be disinfected daily. 

We recommend that mobile computers used by patients be disinfected before the next 
patient uses it.

Cleaning the 
garment

Wash contaminated garments with laundry detergent and hot water or with a phenolic 
household detergent. The garment should be washed and rinsed a second time without 
the phenolic.

Air dry the garment only.

Cleaning recording 
equipment and 
supplies after 
contact with Jacob 
Creutzfeld disease

Ancillary electroneurodiagnostic supplies and equipment such as 
cables, marking pencil, and recording instrument should be wiped down with 
undiluted bleach or a 1 N sodium hydroxide solution (Airman 2000). If items 
cannot be disinfected in this manner, they should be disposed of and not reused. 
We recommend that you follow your internal infection control policies.
1-12  April 27, 2015
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Preventive maintenance

Electrical safety testing is recommended. It is recommended a schedule be 
established for these purposes, with at least an annual cleaning and safety 
testing. This system does not require calibration unless otherwise stated.

Preventative maintenance does not require access to the interior of the 
instrument and may be performed by the user. For this device, preventative 
maintenance consists of periodically cleaning and inspecting the exterior of the 
instrument.

It is recommended that all repairs be performed by a qualified Natus Neurology 
Incorporated service representative only. You have the sole responsibility for any 
malfunctions resulting from improper maintenance or repair by anyone other 
than an authorized Natus Neurology Incorporated representative.

If the system is not functioning properly, do not operate it until all necessary 
repairs are made and the unit is tested for proper functioning in accordance with 
Natus Neurology Incorporated published specifications. It is recommended that 
all repairs be performed by a qualified service representative only.

Switch off all power to the system before attempting any service, maintenance, 
or preventive maintenance.

If the system or any component is repaired, it is recommended that all system 
functionality be checked and an electrical safety test be performed prior to 
resuming use.
April 27, 2015 1-13
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2 Using the garment
This chapter describes how to use the Nicolet EEGwireless32/64 amplifier 
garment as well as how to clean the garment.
April 27, 2015 2-1
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Garment
Cable and insert the Nicolet EEGwireless32/64 amplifier into the garment

NOTE: See the next chapter for additional cabling information.

1. Snap the battery pouch to the four snaps on the garment (Figure 1).

1
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Nicolet Systems
2. (Optional) - Connect the optional battery cable extender(s) to the Nicolet 
EEGwireless32/64 amplifier and then connect the battery cable(s) between the 
extender cables and the battery(s), (Figure 2). Skip steps 3 and 4.

3. Connect the primary battery to the Nicolet EEGwireless32/64 amplifier (Figure 
3).

4. Connect the second battery cable to the Nicolet EEGwireless32/64 amplifier if 
using an optional second battery.

5. Connect the optional Patient Event button to the Nicolet EEGwireless32/64 
amplifier.

6. Connect the optional SpO2 to the Nicolet EEGwireless32/64 amplifier.
7. Insert the Nicolet EEGwireless32/64 amplifier into the carrying case.

- 3 -
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Garment
8. Fold the side flap over the front and snap (Figure 4).
9. Fold the bottom flap up (Figure 5).
10. Fold the top flap down and snap to the bottom flap (Figure 6). 

4
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Attaching the garment

Ensure proper fit before using the 
garment to guard against injury.

Option 1 - Without optional second battery

This option straps the Nicolet EEGwireless32/64 
amplifier, headbox, battery pouch and electrode 
sleeve to the patient.

Attach the garment to the patient

1. Clip the shoulder straps to the bottom fastening 
loop (R1) for the right shoulder (Figure 1).

2. Hang the shoulder strap assembly over the 
patient’s shoulder and clip the other end of the 
shoulder strap to the top fastening loop (R2).

3. Repeat steps 1 (L1) and 2 (L2) for the left 
shoulder strap.

4. Feed the electrode leads through the electrode 
sleeve (4).

5. Adjust the straps as necessary for a snug fit.

Attach the optional belt to the patient

1. Clip the belt to either the bottom (B1) or top (T1) 
fastening loop as shown in Figure 2.

2. Wrap the belt behind the patient.
3. Clip the belt to the bottom (B2) or top (T2) 

fastening loop.

4. Adjust the belt as necessary for a snug fit.

 Figure 1: Shoulder straps.

Figure 2: Belt.
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Garment
Option 2 - With optional second battery

This option straps the Nicolet EEGwireless32/64 
amplifier, headbox, battery pouch, electrode sleeve 
and optional second battery to the patient.

Attach the garment to the patient

1. Clip the shoulder straps to the bottom fastening 
loop (R1) for the right shoulder (Figure 1).

2. Hang the shoulder strap assembly over the 
patient’s shoulder and clip the other end of the 
shoulder strap to the top fastening loop (R2).

3. Repeat steps 1 (L1) and 2 (L2) for the left 
shoulder strap.

4. Feed the electrode leads through the electrode 
sleeve (4).

5. Adjust the straps as necessary for a snug fit.

Attach the optional second battery

NOTE: The belt battery can be the primary battery.

1. Feed the belt through the belt loop (1) on the back 
of the battery pouch (Figure 2).

2. Clip the belt strap to the bottom fastening loop (2).
3. Wrap the belt around the patient’s waist and clip 

the belt to the other fastening loop (3).
4. Connect the battery cable to the optional second 

battery (4).
5. Adjust the belt as necessary for a snug fit.

 Figure 1: Shoulder straps.

Figure 2: Optional second battery.
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3 Cabling the system
This chapter contains the cabling diagrams for the various configurations 
available for use with the Nicolet EEGwireless32/64 amplifier.

NOTE: Connector styles in this chapter may vary from those shown.
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EEGwireless32/64 Connections
Power cable lengths
The battery cable lengths are 11 inches, 30 inches and 15 feet.

Power connector orientation
The power connection for this amplifier is a keyed push-in connector. The connector 
has 2 built in keying notches, which are delineated by two arrows indicating the top of 
the connector plug. This design is intended to guard against the power connector 
being inserted in the wrong orientation, which can result in damage to the amplifier 
and/or power connector. Refer to the figure below, which shows the proper 
orientation of the power connector with the two arrows facing upwards before 
plugging the connector into the battery, amplifier or wallplate.

1 wEEG wallplate

2 Battery/Charger

3 Nicolet EEGwireless amplifier

4 Align the two notches with the two connector grooves on the wEEG wallplate, 
Battery/Charger and Nicolet EEGwireless amplifier before plugging in the connector.
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Cabling the amplifier to be wireless with access point and hospital mains 
power (shown in battery charging mode, fixed install) 

Legend Description

A Amplifier

B Access point (connected to hospital network)

C Antenna

D Photic strobe (option)

E Event button (option)

F SpO2 (option)

G Medical grade power supply (PSU-EEG64)

H Battery with charger (Nicolet CHG1)

I Hospital mains

J Photic cable
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EEGwireless32/64 Connections
Cabling the amplifier to be wireless with access point and Battery Power 
(shown with two battery packs, WiFi - roaming mode) 

Nicolet  wirelessEEG32AA

B

C
D

E

F
G

 

Legend Description

A Amplifier

B Access point (connected to hospital network)

C Antenna

D Event button (option)

E SpO2 (option)

F Battery with charger (Nicolet CHG1)

G Optional second battery with charger (Nicolet CHG1)
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Cabling the cart based system, wired network communication to a 
desktop computer with power supply and battery (cart mount, computer 
peripherals not shown)

Nicolet  wirelessEEG32A

1
2

3
4

5

1
23

A

B

C D

E

F

GH

I

J

K

L

M

Legend Description Legend Description

A Amplifier I Network switch

B Photic strobe (option) J Computer

C Event button (option) K Monitor

D SpO2 (option) L Medical grade power supply (PSU-EEG64)

E Isolation transformer (Required with a Desktop 
computer in a patient room)

M Photic cable

F Hospital mains 1 Connect to USB Port for power

G Medical grade power supply (PSU-EEG64) 2 Connect to LAN Port

H Battery with charger (Nicolet CHG1) 3 Connect  to hospital network
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EEGwireless32/64 Connections
Cabling the PanelPC with wired network communication and a supply or 
battery

Nicolet  wirelessEEG32A

1

2

1
2

3
4

5

3

A
B

C
D

E
F

G

H

I

J
K

NOTE: US and Canada are required to only use 115VAC input power on the Panel PC Power Pack.

Legend Description Legend Description

A Amplifier H Network switch

B Photic strobe (option) I PanelPC

C Event button (option) J Medical grade power supply (PSU-EEG64)

D SpO2 (option) K Photic cable

E Hospital mains 1 Connect to USB Port for power

F Medical grade power supply (PSU-EEG64) 2 Connect to LAN Port

G Battery with charger (Nicolet CHG1) 3 Connect to hospital network
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Cabling the wired network communication to a laptop with power supply 
or battery

Nicolet  wirelessEEG32A

1 2

1
2

3
4

53

A

B

C

D

E

E

F
G

H

I
J

K

L

NOTE: US and Canada are required to only use 115VAC input power on the Laptop Power Pack.

Legend Description Legend Description

A Amplifier I Laptop Power Supply

B Photic strobe (option) J Laptop

C Event button (option) K Medical grade power supply (PSU-EEG64)

D SpO2 (option) L Photic cable

E Hospital mains 1 Connect to Network Extender Card

F Medical grade power supply (PSU-EEG64) 2 Connect to USB Port (for switch power only)

G Battery with charger (Nicolet CHG1) 3 Connect to hospital Network

H Network switch
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EEGwireless32/64 Connections
Cabling the computer

1
2

3
4

51

A
B C

D E

FH

I

J
K

L

1
2

3
4

G

G

2

3

4 5

 with video options

Legend Description Legend Description

A Isolation transformer J Camera power supply

B Access point (Wireless Amplifier option only) K IR Illuminator (option)

C Antenna L Camera (option)

D Computer

E Ethernet to hospital network wallplate 1 From wired amplifier

F Network switch 2 Connect to USB port for power

G Audio 3 Digital Video - to Option 1 (4) or Option 2 (5)

H Mouse 4 Digital Video Option 1

I Keyboard 5 Digital Video Option 2
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Cabling the amplifier for use with the configuration utility

Nicolet  wirelessEEG32A

A

C
B

D

Micro 
USB cable

Legend Description Legend Description

A Amplifier C Medical grade power supply (PSU-EEG64).

B Hospital mains D Computer
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4 Nicolet EEGwireless32/64 Amplifier 
Operation
This chapter describes how to operate the Nicolet EEGwireless32/64 amplifier. 

Please see Chapter 5 for instructions on operating the Nicolet EEGwireless32/64 
amplifier connected to a Nicolet brand system.
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Nicolet EEGwireless32/64 Operation
General information
The Nicolet EEGwireless32/64 amplifier includes safety features that assure that the 
internal batteries always operate within their required temperature range and that the 
surface temperature of the amplifier is always within regulatory requirements during 
normal operation.

Please follow the following general guidelines when the Nicolet EEGwireless32/64 
amplifier is worn by the patient:

1. Make sure the Nicolet EEGwireless32/64 amplifier is always visible to the 
operator, e.g., worn outside a thicker robe or hanging from a bed-rail or head 
board, either in the garment or the amplifier by itself.

2. Periodically check the LED indicators on the front of the Nicolet EEGwireless32/
64 amplifier; if the Power button LED turns mainly yellow instead of mainly 
green, this is an early indication of increased operating temperature; this is no 
problem by itself, but try to stabilize or decrease the ambient temperature. Refer to 
the Power LED color code information in Chapter 11 for additional Power LED 
conditions.

3. Always use the transparent headbox wiring cover.
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Turn on the amplifier
1. Press the Power button (A in Figure 1) for 3 - 5 seconds.

When power is turned on, the Power LED (B) illuminates.

 Figure 1

Error codes Refer to the Error Codes chapter at the end of this manual for a description on how 
the amplifier alerts you to an error and how to manage it.

A B
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Nicolet EEGwireless32/64 Operation
Perform an impedance test from the amplifier

The Headbox connects to the amplifier and provides an interface for impedance 
testing without using a Nicolet brand system. 

NOTE: If you disconnect the Headbox from the Amplifier during an Impedance test 
and then reconnect it, the LEDs on the Headbox will not reappear. You must restart 
the Impedance test to illuminate the LEDs again.

1. Hold down the Impedance Check button (A in Figure 1) for 12 seconds to initiate 
the impedance check.

2. Press the Impedance Check button repeatedly until the desired impedance range: 
2, 5, 10, 20, 50 Kohms LED (B) illuminates.

NOTE: Range changes on release of the button.

3. Hold down the Impedance Check button again for 12 seconds to exit the 
impedance check. 

4. In a standalone mode, the impedance values are displayed on the amplifier but are 
not recorded to the study. It is noted in the study that an impedance test was 
performed.

 Figure 1

A B
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Impedance 
indications

The LEDs (A in Figure 1) on the back of the Headbox indicate the impedance of the 
connected electrodes within the range selected when the Impedance check button is 
pushed.

Unlit Impedance LEDs identify “in range” electrode impedances. 

Orange Impedance LEDs identify “out of range” electrode impedances. 

For electrodes with ‘out of range’ impedances:

1. Check the electrode connections to the amplifier.

Electrodes with “out of range” impedances may appear noisier 
than those with “in range” impedances.

2. Perform troubleshooting steps, if desired.
3. Repeat the impedance steps.

 Figure 1

NOTE: This amplifier will always have the LEDs displayed Orange if they are not 
connected.  There is not a way to turn them off if the electrode is not used. This is 
different than other Nicolet amplifiers where you could disable them if they were not 
needed.

A
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Nicolet EEGwireless32/64 Operation
Stand Alone Mode feature (starting a recording from the amplifier)
You can now start a study from the amplifier without having a Nicolet brand system 
attached. This study doesn't have patient identification until it is connected to a 
Nicolet brand system at which time you can register the amplifier and assign patient 
demographic information in NicVue. If the amplifier has not been connected to a 
Nicolet brand system, the patient information appears as all zeroes. You can acquire 
multiple studies from a single patient when connected to a Nicolet brand system, all 
data will appear with appropriate start and stop times and dates marked. 

NOTE: To acquire data from another patient, you must first connect to a Nicolet 
brand system and download all stored data before beginning a recording on a 
second patient. Only one study can be performed on the amplifier before data is 
cleared from memory. See Clearing the amplifier’s onboard memory later in this 
chapter.

1. Press the Start Recording button for 3 - 5 seconds to start a study.
2. The Start Recording LED illuminates when the study starts (Figure 1).

 Figure 1

A Start Recording button

B Start Recording LED

Nicolet  EEGwireless32A

A B
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Start a study from the amplifier
If you attempt to start a study and the Stop Recording button blinks (C in Figure 1), 
that is an indication that data is present on the amplifier and you cannot start a study. 
See Clearing the amplifier’s onboard memory section later in this chapter to clear 
data from the amplifier.

1. Press the Start Study (Record) button (A in Figure 1) for 3 - 5 seconds to start a 
study. 

The Study Started LED (B) illuminates when the study starts.

Stop a study from the amplifier
1. Press the Stop Study button (C in Figure 1) for 12 seconds to stop a study. 

The Study Stopped LED (D) illuminates and the Study Started LED (B) turns 
off when the study stops.

 Figure 1

Turn off the amplifier
1. Press the Power button (A in Figure 2) for 12 seconds.

When power is turned off, the Power LED (B) turns off.

 Figure 2

A B C D

A B
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Nicolet EEGwireless32/64 Operation
Memory capacity
See Chapter 8 for information about memory capacity. When the amplifier has 
approximately an hour of storage left, the green Record button displays a flashing 
LED (button X on page 1-5) and an auditory warning sounds. 

Clearing the amplifier’s onboard memory
While recording a study, the amplifier records all data collected to its onboard 
memory. Data may be erased from this onboard memory only with user intervention. 
The data must be erased before starting a new study or to continue an extended study.

If the amplifier’s data has not been cleared after an exam was completed, the 
Amplifier Contains Data menu appears when attempting to start a recording. This 
prompt shows the size of the exam located on the amplifier, the patient ID under 
which it was recorded, and the start/stop time of the recording. There are three options 
on this screen, which are detailed below.

Delete Data on Amplifier – This deletes the data on the amplifier and allows you to 
start a recording.

Exit and Retrieve Data – This downloads the data to the currently selected Patient.  
Choosing this option on a different patient will warn you that the Patient ID’s do not 
match.

Cancel – This option cancels the Amplifier Contains Data window. The recorder 
will still continue to start, with this amplifier not available. The Amplifier Selection 
menu and the Recorder will have to be closed.
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• If you know the Data has been successfully downloaded, you can press Delete Data 
on Amplifier button and continue the recording as planned.

• If you’re unsure, and want to check that this patient ID has this exam on the PC, you 
will have to check your patient/exam list and cancel the recording. This is done by 
1. Select Cancel on this menu.
2. Select Cancel on the Amplifier Selection screen.
3. Close the recorder program using the X in the top right of the Amplifier 

Selection screen. 

This will return you to the patient list allowing you to search for the Patient ID 
listed in the Amplifier Contains Data menu. If the full exam does not appear in 
the patient list, you will have to download the data from the Amplifier to the PC.
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Nicolet EEGwireless32/64 Operation
Downloading data from the Amplifier to the PC 
1. Locate the correct Patient ID in the Patient List. 
2. Right-click patient name > Acquire > NicoletOne. 
3. The Amplifier Contains Data dialogue box reappears, asking what you would like 

to do with the Data on the Amplifier.
4. Select Exit and Retrieve Data. 

NOTE: If the Patient ID’s do not match, you will receive a message warning that the 
ID’s are different and if you want to proceed. 

The Recorder window will open and close briefly, and the File Catch-up Details box 
will show the status of the exam being copied from the Amplifier to the PC. You may 
minimize this window, however closing it will stop this process. File Catch-up will 
need to complete before using the Amplifier again. Once this process completes, you 
can choose to Delete Data on Amplifier when starting a new exam. 

NOTE: Choosing Exit and Retrieve Data in this fashion will download the EEG 
data from the amplifier, and will not contain the annotations or events entered by the 
technician at the beginning of the exam.

These annotations can be preserved by retrieving the data by reviewing the original 
exam: 

1. Connect the amplifier to system. Ensure it is not currently recording, press the 
Stop recording button on the amplifier if necessary. 

2. Choose to review the original exam.
3. You will get a prompt stating that there is data on the amplifier and to Download 

the data now, or to Mark the exam as complete. 
4. Choose Download the data now. The Merge Process will start and append the 

data to the end of this exam, including the original annotations/events.

Internal SpO2 operation
1. The amplifier supports the acquisition of SpO2 data. The amplifier has a built in 

Nonin model for heart rate, pleth, SpO2. To acquire SpO2 data, connect a Nonin 
finger probe with optional extension cables to the amplifier. Please refer to the 
Nicolet Software Reference guide for instructions on using vital signs or an 
external SpO2 device. See Amplifier symbols and components in Chapter 1 for 
the connection port.
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5 Using the Nicolet brand system to 
setup and acquire EEG
This Chapter describes how to operate the Nicolet EEGwireless32/64 amplifier 
controls from the Nicolet brand system. Please see the previous chapter for 
instructions on controlling the Nicolet EEGwireless32/64 amplifier without the 
Nicolet brand system.
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Using the Nicolet system to setup and acquire EEG
Using the Nicolet brand system to setup and acquire EEG with the 
EEGwireless32/64 amplifier

This procedure describes using the Nicolet brand system to setup and acquire EEG.

For more information, please see the Nicolet Software Reference guide 269-604601 
(CD part number 482-639403).

Wireless panel information
Figure 1 shows the Wireless information panel. The Wireless panel provides the 
following information.

 Figure 1: Wireless information panel.
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Nicolet Systems
Battery life Each of the battery ports on the amplifier display either the total battery life 
remaining, or “AC-Power” if the port is connected to AC Power. The Internal 
indicator displays the internal battery life remaining.

Connection quality The Connection Quality indicator indicates the quality of the signal being received by 
the amplifier

Signal strength The Signal Strength indicator indicates the strength (power) of the signal being 
received by the amplifier.

Storage Both the maximum total storage on the amplifier’s onboard storage as well as the total 
remaining storage are displayed. An estimate of the total storage time remaining, 
given the current sampling rate, is also displayed.

Catchup A display indicating if the amplifier is In Range (connected) of the Acquisition 
station or Out Of Range (disconnected) of the Acquisition station is located above 
the “Catch-up Status” field. Live Data Delay indicates how much time lag there is 
between live data and the data displayed on the Nicolet screen display. The time it 
takes to show live data may be more or less than this time. File Split In indicates the 
amount of time the amplifier can remain out of range before the current exam file is 
split.
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Using the Nicolet system to setup and acquire EEG
Starting a study

Select the amplifier 
for the study

To start a study while connected to a Nicolet acquisition station, either directly or 
over a network, you must first select an amplifier from which to acquire EEG.

1. Each amplifier has a unique identifier (Figure 2). Select the amplifier from the 
Wireless Panel dialog with the same identifier as your amplifier. If the dialog in 
Figure 2 does not appear and you see an “Amplifier Disconnected,” select the 
proper Protocol from the Protocol menu to view the wireless panel dialog.

 Figure 2.

NOTE: In the event that the amplifier you select is still storing data from a previous 
exam, you will see a prompt asking you to either download the data or erase the data 
from the amplifier. If you choose to download the data, the amplifier will perform 
data catch-up. See Data Catch-Up in this chapter for more information. Also see 
Clearing the amplifier’s onboard memory in Chapter 4.
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Select a protocol To start an exam through the Nicolet brand system, you must first select a protocol to 
run. 

There are protocols specific to the amplifier that must be 
selected to ensure proper operation.

1. From the Options menu, select Protocols.

2. Click Protocol > EEGwireless32 (or EEGwireless64) depending on the number 
of channels with which your amplifier is configured.

3. The amplifier is ready to start acquiring data.

NOTE: If you change to a different protocol (e.g., 64 wireless to a 32 wireless) when 
Powerloss Recovery is enabled, you will have a two minute delay before you can 
proceed with the recording.

Change/View the 
sampling rate

The current sampling rate can be changed and viewed in Acquisition:

1. Select the Settings pane.

2. Select Amplifier.

The sampling rate can be viewed in Review:

1. Select Tools > Report > Wireless Audit Log.

- or -

2. Select View > Recorded Channels.
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Using the Nicolet system to setup and acquire EEG
Check the 
impedance

NOTE: Skip step 13 if the Startup in Impedance mode checkbox was checked 
earlier (Tools > Options > Acquisition tab). Checking this box causes the 
Impedance window to appear automatically when you open the Recorder software. 
Please refer to the Nicolet Brand System Software Reference Guide, Miscellaneous 
Quick Steps chapter, Acquisition tab for additional information.

NOTE: If you disconnect the Headbox from the Amplifier during an Impedance test 
and then reconnect it, the LEDs on the Headbox will not reappear. You must restart 
the Impedance test to illuminate the LEDs again.

3. Select Impedance  to display the Impedance Test window. 

- or -

Select Acquisition > Impedance.

4. Select the acceptable impedance range: 

Click on the Threshold show menu button and then select the desired 
threshold value.

- or -

Enter a custom value.
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5. The measured impedance values are displayed for each electrode. 
• Electrodes with in range impedances are displayed in green. 
• Electrodes that are out of range are displayed in red. Allow time for the 

Impedance Test window to update as you work to lower impedances as 
necessary.

6. When the impedances are in range, select Start.

7. The Recorder window appears with a watermark that says “Not Recording” and 
with the EEG scrolling across the screen, but not yet being saved to the hard 

drive. Select Record  to start the recording unless the EEG was initiated 
using “Quick Start”.

Impedance 
threshold check

The impedance threshold check can be performed either from the amplifier or from 
the software. To check the impedance from the amplifier see Chapter 3.

8. Click on Options > Impedance Check.

9. Click Start Impedance Check.

10. The impedances are displayed on the Nicolet Acquisition screen.
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Using the Nicolet system to setup and acquire EEG
Start recording EEG 11. If the Impedance Check panel was enabled to appear automatically when the 
Recorder application was started, the system begins recording as soon as you 
close the Impedance Check panel.

If the feature was not enabled, select Record start recording.

NOTE: Select Record again to stop recording EEG.

NOTE: If the patient goes out of range while performing an impedance check, 
the impedance values will not be recorded.

Disconnecting from 
the system

In the event that the amplifier becomes disconnected from the Nicolet acquisition 
station or the network, either accidentally or intentionally, the amplifier stores its 
neurodiagnostic information onboard. For more information see the Catch-up section 
in Chapter 3.
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Nicolet Systems
Optional steps The following describes how to enable/edit various features/parameters available on 
the Nicolet acquisition system.

Enabling automatic 
impedance testing 
after changing the 
montage

The system can test the electrode impedances each time you change to a different 
montage.

1. Select Settings  and then Misc at the bottom of the Editor window.

- or -

Select Protocol > Settings and then Misc at the bottom of the Editor window.

2. Checkmark Automatic Impedance Test on Montage Change.

3. Select Save.

4. Select Close.

Edit the parameters Display the Control Panel

1. Select Panel .

2. Select View > Panel > Format to display the Format palette, which lets you 
easily change the sensitivity, LFF, HFF, timebase, montage and the number of 
channels displayed.
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Using the Nicolet system to setup and acquire EEG
Select the montage

1. From the Control Panel, select the Montage button on the Format palette and 
then select the desired montage.

- or -

Select Format > Montage and then select the desired montage.

- or -

Select the desired Montage shortcut button. 

- or -

Right-click on the trace labels, select Montage and then select the desired 
montage.

NOTE: If the Laplacian button becomes disabled:

1. Open the Calculated Channels editor.

2. Select one (and only one) sensor on the Head view.

3. The Laplacian sensor button will be enabled at this point. Once pressed, you 
will be in the Laplacian mode. Subsequent sensor selections will be 
weighted appropriately.
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Nicolet Systems
Select the Sensitivity

1. From the Control Panel, select the Sensitivity button on the Format palette and 
then select the desired sensitivity.

- or -

Select Montage > Sensitivity and then select the desired sensitivity.

- or -

Right-click on the trace labels, select All Traces > Sensitivity and then select 
the desired sensitivity.

- or -

Right-click on the trace labels, select Adjust Selected and then select the desired 
sensitivity. 

Select the Timebase

1. From the Control Panel, select the Timebase button on the Format palette and 
then select the desired timebase.

- or -

Select Montage > Timebase and then select the desired timebase.

- or -

Right-click on the trace labels, select All Traces > Timebase and then select the 
desired timebase.
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Using the Nicolet system to setup and acquire EEG
Select the High Cut/Low Cut filters 

1. From the Control Panel, select the High Cut or Low Cut button on the Format 
palette and then select the desired filter settings.

- or -

Select  Montage > High Cut/Low Cut and then select the desired filter settings.

- or -

Right-click on the trace labels, select All Traces, select HighCut/LowCut and 
then select the desired filter settings.

- or -

Right-click on the trace labels, select Adjust Selected, select HighCut/LowCut 
and then select the desired filter settings. 

Selecting additional Filters

In NicoletOne there is a dropdown list of high cut and low cut filters. Additional filter 
settings may be selected, up to the Nyquist Rate (one half of the current sampling 
frequency). 

To select custom filter settings:

1. Right-click on the list of channels on the left hand side of the NicoletOne screen.

2. Select All Channels.

3. Select High Cut Filters or Low Cut Filters.

4. Choose Custom.

5. You can now enter a numerical value for the filter.
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Turn the Notch filter on 

1. Select Notch .

- or -

Select Montage > Notch.

- or -

Right-click on the trace labels, select All Traces and then select Notch. 

- or -

Right-click on the trace labels, select Adjust Selected and then select Notch.

Display the Reader 
window (optional)

1. Select Review  to display the Reader window to the left of the Record 
window if you want to review the EEG (or look back in the EEG) while it is 
being recorded.

NOTE: The Reader window does not update automatically. To view the latest EEG 

that was recorded, select End .
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Splitting long 
recordings into 
multiple files 

You can split the recording into multiple files at a specified time or at the end of a 
predetermined file duration.

1. Select Settings  and then select Misc at the bottom of the Editor window.

- or -

Select Protocol > Settings and then select Misc at the bottom of the Editor 
window.

Splitting the recording at a specified file duration

 a. Click on the Maximum File Duration radio button.
 b. Select the file duration after which the file will close and a new file begins 

storing data.
 c. Select Save.
 d. Select Close.

Splitting the recording at a specified time

 a. Click on the Start New File at radio button.
 b. Select the time of day (AM or PM) at which you want the file to close and a 

new file begins storing data.
 c. Select Save.
 d. Select Close.
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Data catch up
In the event that the amplifier fails to communicate to the network or the acquisition 
station being used to acquire data, the amplifier stores data locally. The amplifier has 
onboard memory and stores all data acquired (EEG and Patient Event) to its onboard 
memory. When the amplifier communication is restored to the network or acquisition 
station, the data stored locally on the amplifier is transmitted along with the current 
(live) data.

NOTE: The memory card for internal storage is not user accessible.
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Using the Nicolet system to setup and acquire EEG
Data catch up  
(disconnected less 
than 10 minutes)

The following applies to an amplifier wired to the Nicolet acquisition station with no 
wireless capability.

NOTE: If the amplifier is in range of a wireless access point, disconnecting the 
amplifier’s Ethernet cable will not result in an interruption of data to the Nicolet 
acquisition station.

Scenario

The amplifier is acquiring data for a study and is connected either:
• directly to a Nicolet acquisition station 

- or -
• to a network running the Nicolet acquisition station.

 a. The Ethernet cable connecting the amplifier to the Nicolet acquisition station 
is disconnected causing the Nicolet software to display an alert that a 
disconnect has occurred.

 b. The disconnect lasts less than 10 minutes. The default is 10 minutes.
 c. The amplifier is reconnected to the network or to the same Nicolet 

acquisition station to which it was initially connected. 
 d. After a moment, the Nicolet acquisition station displays that the amplifier 

has been reconnected.

Do not stop acquisition from the Nicolet acquisition station until 
data catchup is complete as indicated when the wireless panel displays ‘In 
Range’ and the fast scrolling catchup eeg returns to live data.
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Data catch up  
(disconnected more 
than 10 minutes)

The following applies to an amplifier wired to the Nicolet acquisition station or 
operating in the Wireless mode.

NOTE: If the amplifier is in range of a wireless access point, disconnecting the 
amplifier’s Ethernet cable will not result in an interruption of data to the Nicolet 
acquisition station.

The amplifier is acquiring data for a study and is connected either:
• directly to a Nicolet acquisition station 

- or -
• to a network running the Nicolet acquisition station

 a. The Ethernet cable connecting the amplifier to the Nicolet acquisition station 
is disconnected, causing the Nicolet software to display an alert that a 
disconnect has occurred.

 b. The disconnect lasts longer than 10 minutes.
 c. The amplifier is reconnected to the network or to the same Nicolet 

acquisition station to which it was initially connected. 
 d. After a moment, the Nicolet acquisition station displays that the amplifier 

has been reconnected. A file split occurs when the amplifier comes back into 
range.

 e. Click the system tray icon to view the file catchup details including file 
progress.

Do not stop acquisition from the Nicolet Acquisition station until 
data catchup is complete as indicated by the file catchup details window that 
appears in the system tray. Video will not be available, when reviewing the exam, 
for the period of time the amplifier was disconnected.
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Using the Nicolet system to setup and acquire EEG
Changing the 
sampling rate

1. Select Settings > Amplifier.
2. Select your sampling frequency from the "Common Sampling Rate" menu (Figure 

1). You can select specific sampling frequencies between 128 Hz to 12000 Hz.

 Figure 1.

NOTE: If you select a sampling rate over 4096 Hz while in the wireless mode, you 
will be prompted to turn the wireless module off. If you choose not to turn it off, your 
sampling rate will not be changed. If you choose to turn it off, in order to re-enable 
the wireless module, you must power cycle the amplifier.
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Wireless Operation
Wireless operation
The maximum wireless sampling rate is 4096Hz. If you select a sampling rate above 
this, the Acquisition software will warn you that you need to turn off wireless in order 
to sample at a higher rate. If you accept this change, you must power cycle the 
amplifier in order to regain wireless connectivity.

Do not use the photic functionality of the wireless amplifier while transmitting 
wirelessly. If you want to perform photic stimulation, connect the ethernet cable to the 
Acquisition station or the network.

There is a 10 minute disconnected threshold that determines if a file split needs to be 
done in order to retrieve data from the amplifier. If the amplifier becomes 
disconnected from the Acquisition station and then is reconnected to the Acquisition 
station and if the time the amplifier is disconnected plus the time it takes for 
NicoletOne to download the data stored on the amplifier is greater than 10 minutes, a 
file split will occur and a file catchup window will appear. Note that this 10 minute 
threshold is not user configurable.

If the Acquisition station on which NicoletOne is running has a power outage, 
NicoletOne will attempt to restart acquisition when power is restored to the 
workstation. If the amplifier that you are using is out of range when NicoletOne 
restarts, it will not restart acquisition on that amplifier. To restart acquisition:

1. Bring the amplifier back into range or tether the amplifier to the workstation.

2. Select the amplifier from the Amp Selection screen.

3. Restart acquisition.

If you check impedance while recording and out of range, upon coming back into 
range, the study will display an overflow error and the recording may stop. To resume 
recording, press the Record button in acquisition. Note that this does not happen 
when file catchup is initiated after coming back in range.

If your wireless amplifier becomes disconnected for extended periods of time, you 
may end up with a number of exam files in NicVue or Study Room. When this occurs, 
you will not end up with a single continuous exam file representing the entire study. 
Each exam segment marked as “DOWNLOADED” is a complete segment of the 
exam. These “DOWNLOADED” files along with the most recently marked exam file 
(which may be a downloaded file if the exam was stopped while the amplifier was 
disconnected) comprise the entirety of the exam.
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7 Using the EEGwireless32/64 
Batteries
This chapter contains information about the batteries that may be used with the 
EEGwireless32/64 amplifier.
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Using the EEGwireless32/64 Batteries
Internal batteries

 Contact Natus Neurology Incorporated Customer Service if you 
believe your internal batteries need to be replaced.

The external battery charge indicators
The five LEDs on the battery charger indicate the current charge (in percent) as 
shown in Figure 1.

 Figure 1.

Legend Description

A Charger (Nicolet CHG1)

C Battery Test Button

B Battery (Nicolet BAT1)
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Checking the batteries charges
1. Display the Wireless Panel pane in the Panel on the right side of the Acquisition 

window; click View > Panel > NicoletOne Wireless Amp Panel.

2. The percent of charge remaining is displayed in the Wireless Panel pane for Bat 
A, Bat B, and Internal batteries.

Below is information regarding the run and life time of the batteries. Note that the 
values here are only estimates. The actual run time and life of the batteries depend on 
how the amplifier is used, how it is charged and other factors.

Battery Life

The following graph shows the expected capacity versus the number of charge cycles. 
Note that this graph only reflects the capacity if the battery is discharged to 0% and 
then charged to 100% for each cycle.

 Figure 1 - Source: Tadiran Batteries LTD
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Using the EEGwireless32/64 Batteries
Battery pack capacity
The table below indicate the approximate number of hours the amplifier can acquire 
data without recharging the external battery pack.

NOTE: This is for a single battery pack; your battery life will approximately double 
with 2 battery packs connected.

*-You cannot sample above 4096 Hz in the Wireless mode.

Sampling Rate 
(Hz)

32 Channel 64 Channel

Wired
(Hours)

Wireless
(Hours)

Wired
(Hours)

Wireless
(Hours)

    128 12.1 12.2 9.9 9.8

    256 12.1 12.1 9.9 9.8

    512 12.1 12.1 9.9 9.8

 1024 12.0 12.1 9.9 9.8

 2048 12.0 12.0 9.9 9.7

 4096 12.0 11.9 9.9 9.7

 6000 11.9 * 9.7 *

 8000 11.8 * 9.6 *

10000 11.7 * 9.6 *

12000 10.2 * 7.4 *
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Charging the external batteries
While a medical power brick is attached and a battery pack is attached, that battery 
pack will charge.

While an external battery pack or a medical power brick is connected, the internal 
battery will charge.

NOTE: The internal and external batteries will never reach 100% charge (the battery 
trickle charges).

The amplifier provides a continuous beeping when the external battery pack is below 
20% charge, or if no external power is connected (running on internal batteries). 
Replace the External batteries or the Recorder to a wall outlet.

 Figure 1: External battery and charger.

Replacing a worn 
out external battery

The charger can be removed from a worn battery and reused for a new battery.

1. Remove the charger securing screw (C) in Figure 1 above.

2. Slide the charger off from the battery.

3. Slide the charger on to the new battery.

4. Secure the charger securing screw (C) in Figure 1 above to the new battery.

Legend Description

A Charger (Nicolet CHG1)

B Battery (Nicolet BAT1)

C Tool removable

D Connector (To amplifier or power supply for charging the battery)

TEST

A

B

A

D

C
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Using the EEGwireless32/64 Batteries
Charging the battery 
with a medical grade 
power supply

 Figure 2

Charging the battery 
from the amplifier 
with a medical grade 
power supply

 Figure 3

Legend Description

A Battery (Nicolet BAT1)

B Charger (Nicolet CHG1)

C Medical power supply (PSU-EEG64)

D Wallplate - Hospital mains

A
B

C

D

Legend Description

A Amplifier

B Charger (Nicolet CHG1)

C Battery (Nicolet BAT1)

D Medical power supply (PSU-EEG64)

E Wallplate - Hospital mains

Nicolet  wirelessEEG32A

A

B
C

D E
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Battery indications
The amplifier's Power LED gives an indication of the current state of the 
amplifiers batteries.

If the Power LED is green and blinks briefly every 5 seconds, the the amplifier has 
external power and the internal batteries are charged.

If the Power LED is green and blinks yellow every 5 seconds, then the amplifier has 
external power and the internal batteries are charging

If the Power LED is yellow and blinks every 5 seconds, then the amplifier is 
operating on internal battery power only.

If the Power LED is yellow with no blinking, then the amplifier is operating on 
internal batteries and the internal batteries are low and not charging.
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8 Nicolet EEGwireless32/64 Amplifier 
Onboard Memory
This chapter contains information about the Nicolet EEGwireless32/64 onboard 
memory.
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Onboard Memory
Onboard memory
The amplifier has 32GB onboard memory that records neurodiagnostic information. 
In the event that the amplifier fails to communicate to the network or the Acquisition 
station being used to acquire data, the amplifier stores data locally. The onboard 
memory stores all data acquired (EEG Pulse Oximetry, Impedance Tests and Patient 
Event). When the amplifier communication is restored to the network or Acquisition 
station, the data stored locally on the amplifier is transmitted along with the current 
(live) data.

The data on this memory persists through power cycles. The amplifier can be 
disconnected or out of range for approximately the amount of time shown below, for a 
given channel count and sampling rate. When the amplifier has approximately an 
hour of storage left, the green Record button displays a flashing LED (button X on 
page 1-5) and an auditory warning sounds. 
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IMPORTANT: If the amplifier fails to communicate (e.g., Out of Range) for a 
period of more than 10 minutes (factory set) when performing data catchup, you 
will not have video with the EEG data.

Storage at:

32 Channels 64 Channels
Estimated 

Data Storage 
for 1 Hour 
(Gbytes)

Estimated 
Storage Time 
with 32GB SD 

Card

Estimated 
Data Storage 
for 1 Hour 
(Gbytes)

Estimated 
Storage Time 
with 32GB SD 

Card
12000Hz 4.0 7 Hours 6.6 4 Hours
10000Hz 3.3 8 Hours 5.5 5 Hours
8000Hz 2.6 10 Hours 4.4 6 Hours
6000hz 2.0 14 Hours 3.3 8 Hours
4000Hz 1.3 21 Hours 2.2 12 Hours
2000Hz 0.7 1.5 Days 1.1 1 Day
1000Hz 0.3 3.5 Days 0.6 2 Days
512Hz 0.2 7 Days 0.3 4 Days
256Hz 0.1 14 Days 0.1 8 Days
128Hz 0.1 28 Days 0.1 16 Days
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Onboard Memory
If you are recording at high sampling rates, the exam files size will be very large. We 
suggest you adjust your file split time and file process settings to compensate for this 
additional size.

NOTE: The file size indicated by Nicolet in the Amp Contains Data window is not 
the same as the .e file size on disk. The downloaded .e file will be approximately 70% 
of what is indicated in the Amp Contains Data window.

Data download rate If your amplifier's onboard memory is full and you have the amplifier connected with 
the ethernet cable directly to the Acquisition station, downloading the file will take at 
least 50 minutes for 32 channels and 60 minutes for 64 channels.
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Example modes of operation

Mode 1: Wireless 
with external battery 
pack.

This mode provides the most mobility within the wireless network range.

Example - The amplifier is wired and the patient wants to use the restroom. Use the 
external battery.

Example - You want to change the sheets and need to disconnect the patient for a 
period of time.

Mode 2: Wireless 
with AC power.

This mode is used to charge battery packs while recording data.

Example - You are wireless and need to go to a different floor for an ancillary 
procedure, which does not have wireless access. You can use this mode.

Mode 3: Wired 
network with 
external battery pack

Wired modes allow use of higher sampling rates.

Example - You are wired and want the patient to become mobile and still want to see 
the data. If amplifier is configured with wireless settings disconnecting the network 
cable will change the amplifiers communication method to wireless. You may 
experience a brief disconnection time while switching over to wireless. 

Mode 4: Wired 
network with AC 
power.

Wired modes allow use of higher sampling rates.

Example - You are operating the amplifier on a wired network and the amplifier 
begins to run low on batteries. Connect the amplifier to AC power.

Example - Patient wants to go to sleep.
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9 User Configuration Utility
This chapter describes the configuration utility, which is a piece of software 
independent of the Nicolet brand system. The purpose of the configuration utility 
is to allow you to troubleshoot the amplifier in the event of erroneous operation.
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Configuration Utility
Setup
The configuration utility is installed separately from the Nicolet brand system. To 
install it, follow the instructions that came on the Nicolet CD with your Nicolet brand 
system.

NOTE: The User Configuration Utility displays in the read only mode.

The amplifier uses a micro USB to USB cable to connect to a computer running the 
configuration utility. The USB cable is supplied with the amplifier. The amplifier can 
be connected to a Desktop Computer, PanelPC, or Laptop as shown in Chapter 3 of 
this guide.

After the amplifier is connected to the computer, you can start the application.

1. Click Windows > Start > Config Utility.

2. When the utility launches, you will be prompted for a password. See the 
password that was supplied with the amplifier.

When using the Configuration Utility, you have the ability to set a sampling rate and 
bipolar settings for channels 23-32. These settings are default settings. They will only 
be applied if you power on the amplifier with no stored data and proceed to start a 
study without connecting to NicoletOne. Therefore, for example, if you set the 
sampling rate to 512Hz and channels 23 and 24 to bipolar and the rest to referential, 
upon powering down and powering up the amplifier, starting a study will result in a 
study at 512Hz and with channels 23 and 24 as bipolar. Note that the default settings 
for bipolar channels only apply when a 32 channel headbox is attached to the 
amplifier.
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Configuration Utility 
dialog

The following information can be viewed from the User Configuration Utility dialog.

NOTE: Do not disconnect the USB cable from the amplifier while the configuration 
utility is open.

IP Address / Ports

NOTE: When you upgrade the firmware, all custom settings will be erased. To avoid 
this, first export the settings and then update the firmware.

This section displays the current IP address of the amplifier and the port on which it is 
operating.

NOTE: Do not set the port to anything other than 26010 or the amplifier will be 
unable to connect to the Acquisition station.

MAC Addresses

This section displays the Media Access Control addresses. These are globally unique 
identifiers assigned to network hardware (i.e., a wireless card or an ethernet card).

NOTE: If you change any of these settings, you must power cycle the amplifier for 
the settings to take effect.
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Configuration Utility
Status

The Status section displays the current power level of the amplifier and the remaining 
memory. The memory is displayed in GB, and the power level is displayed as a 
percentage of the remaining battery life or as “Connected” if the amplifier is 
connected to AC power.

Access Points

The Access Points section displays the access points that are currently available and 
in range of the amplifier. Note that after adding all the access point SSID's, you must 
select Apply and reboot the amplifier for the changes to take effect. The amplifier 
attempts to connect to the access points in the order they appear in the dialogue box 
regardless of connectivity strength.

NOTE: You can only enter up to 10 access points into the access point list. The more 
AP’s that you list, the longer the Amplifier will take to successfully negotiate or 
connect to an access point.

DHCP / Static IP

The DHCP section indicates if the amplifier is operating in the DHCP or Static IP 
mode. In the Static IP mode, the IP address is fixed. In the DHCP mode, the IP 
address of the amplifier is determined by the network.
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SSID

This section displays the Service Set Identifier.

Sampling Frequency

The Sampling Frequency section displays the default sampling frequency of the 
amplifier. This is the sampling frequency that is used for the first study when it is 
started from the amplifier without connecting to the Nicolet brand system. If the 
amplifier is connected to the Nicolet brand system and a study is started from the 
software, the sampling rate selected becomes the new default sampling rate until the 
amplifier is power cycled.

NOTE: When entering your WEP encryption key in the configuration utility, ensure 
that it is either 10 or 26 characters and that all of the characters are hexadecimal (i.e., 
either a digit 0-9 or a letter A, D, C, D, E, or F).
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10 Electromagnetic Compatibility (EMC)
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Electromagnetic Compatibility (EMC)
Electromagnetic Compatibility (EMC) Information

Portable and mobile RF communications equipment can affect your product. Install and operate your 
product according to the EMC information presented in this User manual.

The use of accessories, transducers and cables other than those specified, with the excep-
tion of servicing parts sold by Natus Neurology Incorporated as replacement parts for 
internal components, may result in increased EMISSIONS or decreased IMMUNITY of 
the device.

Your Nicolet Brand system has been tested for EMC emissions and immunity as a stand-
alone instrument. Do not use the system adjacent to or stacked with other electronic equip-
ment. If adjacent or stacked use is necessary, the user should verify normal operation in 
that configuration.

EMI by nature can be a possible source of disturbance to electronic equipment. This 
device should be used in an environment free* of other equipment that could be affected 
by interference.  *Environment free is described in IEC 1000-2-3, Part 2, First Edition.

Observe the EN/IEC 60601-1-1 and EN/IEC 60601-1-2 standards in case of connection 
with other instruments. The connection of the equipment with other devices is allowed 
only when the safety requirements for the patient, the user and the environment are not 
compromised. If the Manual does not contain adequate information about the possibility 
of interconnection with other devices, the user should contact the manufacturer or the 
nearest authorized servicing center to obtain information about the effects that coupling 
devices may have on the patient, the user and the environment.
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Radio transmitting equipment, cellular phones, etc. shall not be used in the close proxim-
ity of the device since this could influence the performance of the device.

Be careful using the equipment in locations disturbed by strong magnetic fields. The 
equipment is compliant with the EMC requirements (Electromagnetic Compatibility) 
according to what specified by the EN 60601-1-2 standard. It is recommended that the 
equipment be kept away from disturbance sources and induced electromagnetic fields sur-
passing the values prescribed by the standard in order to avoid any possible instabilities 
and malfunctioning of the equipment.

Medical Electrical Equipment needs special precautions regarding EMC and needs to be 
installed and put into service according to the EMC information provided in this User 
manual.

Portable and mobile RF communications equipment can affect the Equipment. Install and 
operate the Equipment according to the EMC information presented in this manual.

Pins of Trigger In, Trigger Out, Event button, mini-USB and Ethernet connectors identi-

fied with the ESD warning symbol should not be touched and connections should not 
be made to these connectors unless ESD precautionary procedures are used.

Precautionary procedures include:

• Methods to prevent build-up of electrostatic charge (e.g., air conditioning, humidifi-
cation, conductive floor coverings, non-synthetic clothing);

• Discharging one’s body to the frame of the EQUIPMENT or SYSTEM or to earth or a 
large metal object;

• Bonding oneself by means of a wrist trap to the EQUIPMENT or SYSTEM or to 
earth.
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Staff that could touch connectors identified with the ESD warning symbol should receive 
this explanation and training. This includes clinical/biomedical engineering and health-
care staff.

ESD training should include an introduction to the physics of electrostatic charge, the 
voltage levels that can occur in normal practice and the damage that can be done to elec-
tronic components if they are touched by an OPERATOR who is electrostatically charged. 
Further, an explanation should be given of methods to prevent build-up of electrostatic 
charge, and how and why to discharge one’s body to earth or to the frame of the EQUIP-
MENT or SYSTEM, or bond oneself by means of a wrist strap to the EQUIPMENT or 
SYSTEM or to earth prior to making a connection.

Model Signal Cable
Maximum Allowable Cable 

Length Limits

Nicolet EEGwireless32/64 
Amplifier

Event button (option) 15ft (457.2cm)

SpO2 60in (152.4 cm)

Medical grade power supply (PSU-
EEG64).

DC = 15ft (457.2cm)
AC =  9ft (274.32cm).

Battery with charger (Nicolet CHG1) 30in (76.2cm)

Photic cable 100in (254.0cm)

Headbox cable 30ft (914.4cm)

Headcap cable 15ft (457.2cm)
April 27, 2015 10-5



Nicolet Systems
Nicolet EEGwireless32/64 Amplifier - Electromagnetic Compatibility 
(EMC) Information

Portable and mobile RF communications equipment can affect the Nicolet EEGwireless32/64 amplifier. Install 
and operate the Nicolet EEGwireless32/64 amplifier according to the EMC information presented on this page 
and the next 4 pages.

The Nicolet EEGwireless32/64 amplifier has been tested for EMC emissions and immunity as a standalone 
instrument. Do not use the Nicolet EEGwireless32/64 amplifier adjacent to or stacked with other electronic 
equipment. If adjacent or stacked use is necessary, the user should verify normal operation in the configuration

Recommended separation distances between portable and mobile RF 
communications equipment and the Nicolet EEGwireless32/64 amplifier

The Nicolet EEGwireless32/64 amplifier is intended for use in an electromagnetic environment in which radiated RF 
disturbances are controlled. The customer or the user of the Nicolet EEGwireless32/64 amplifier can help prevent 
electromagnetic interferences by maintaining a minimum distance between portable and mobile RF communications 
equipment (transmitters) and the Nicolet EEGwireless32/64 amplifier as recommended below, according to the maximum 
output power of the communications equipment.

Rated Maximum output 

power of transmitter

W

Separation distance according to frequency of transmitter
m

150 kHz to 80 MHz

d = 1.17 

80 MHz to 800 MHz

d = 1.17 

800 MHz to 2.5 GHz

d = 2.23 

0.01 0.12 0.12 0.23

0.1 0.38 0.38 0.73

1 1.2 1.2 2.3

10 3.8 3.8 7.3

100 12 12 23

For transmitters rated at a maximum output power not listed above, the recommended separation distance d in meters (m) 
can be estimated using the equation applicable to the frequency of the transmitter, where P is the maximum output power 
rating of the transmitter in watts (W) according to the transmitter manufacturer.

Note 1  At 80 MHz and 800 MHZ, the higher frequency range applies.

Note 2  These guidelines may not apply to all situations. Electromagnetic propagation is affected by absorption and 
reflection from structures, objects and people.
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Nicolet EEGwireless32/64 amplifier connected to a Nicolet brand system

Guidance and manufacturer’s declaration - electromagnetic emissions

The Nicolet EEGwireless32/64 amplifier is intended for use in the electromagnetic environment specified below. 
The customer or the user of the Nicolet EEGwireless32/64 amplifier should assure that it is used in such an 
environment.

Emissions Test Compliance Electromagnetic environment - guidance

RF emissions 

CISPR 11

Group 1 The Nicolet EEGwireless32/64 amplifier uses RF 
energy only for its internal function. Therefore, its 
RF emissions are very low and are not likely to 
cause any interference in nearby electronic 
equipment.

RF emissions 

CISPR 11

Class A The Nicolet EEGwireless32/64 amplifier is suitable 
for use in all establishments other than domestic and 
those directly connected to the public low-voltage 
power supply network that supplies buildings used 
for domestic purposes.

Harmonic emissions 

IEC 61000-3-2

Class A

Voltage fluctuations / flicker 
emissions

IEC 61000-3-3

Complies
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Nicolet EEGwireless32/64 amplifier storing with battery pack connected and wireless disabled

Guidance and manufacturer’s declaration - electromagnetic emissions

The Nicolet EEGwireless32/64 amplifier is intended for use in the el ec to magnetic environment specified below. 
The customer or the user of the Nicolet EEGwireless32/64 amplifier should assure that it is used in such an 
environment.

Emissions Test Compliance Electromagnetic environment - guidance

RF emissions 

CISPR 11

Group 1 The Nicolet EEGwireless32/64 amplifier uses RF 
energy only for its internal function. Therefore, its 
RF emissions are very low and are not likely to 
cause any interference in nearby electronic 
equipment.

RF emissions 

CISPR 11

Class B The (EQUIPMENT or SYSTEM) is suitable for use 
in all establishments, including domestic 
establishments and those directly connected to the 
low-voltage power supply network that supplies 
buildings used for domestic purposes.

Harmonic emissions 

IEC 61000-3-2

Class B

Voltage fluctuations / flicker 
emissions

IEC 61000-3-3

Complies
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Guidance and Manufacturer’s Declaration - Electromagnetic Immunity
The Nicolet EEGwireless32/64 amplifier is intended for use in the electromagnetic environment specified below. The 
customer or the user of the Nicolet EEGwireless32/64 amplifier should assure that it is used in such an environment.

Immunity Test IEC 60601 Test level Compliance Level Electromagnetic 
Environment-Guidance

Electrostatic Discharge (ESD)

IEC 61000-4-2

+6 kV contact

+8 kV air

+6 kV contact

+8 kV air

Floors should be wood, concrete 
or ceramic tile. If floors are 
covered with synthetic material, 
the relative humidity should be 
less than 30%.

Electrical fast transient/burst

IEC61000-4-4

+2 kV for power supply lines

+1 kV for input/output lines

+2 kV for power supply lines

+1 kV for input/output lines

Mains power quality should be 
that of a typical commercial or 
hospital environment.

Surge

IEC 61000-4-5

+1 kV differential mode

+2 kV common mode

+1 kV differential mode

+2 kV common mode

Mains power quality should be 
that of a typical commercial or 
hospital environment.

Voltage dips, short 
interruptions and voltage 
variations on power supply 
lines

IEC 61000-4-11

< 5% UT 
(>95% dip in UT) for 0.5 cycle
40% UT 
(60% dip in UT) for 5 cycles
70% UT
(30% dip in UT) for 25 cycles
<5% UT
(>95% dip in UT) for 5 sec

< 5% UT 
(>95% dip in UT) for 0.5 
cycle
40% UT 
(60% dip in UT) for 5 cycles
70% UT
(30% dip in UT) for 25 cycles
<5% UT
(>95% dip in UT) for 5 sec

Mains power quality should be 
that of a typical commercial or 
hospital environment. If the user 
of the Nicolet EEGwireless32/
64 amplifier requires continued 
operation during power mains 
interruptions, it is recommended 
that the Nicolet EEGwireless32/
64 amplifier be powered from an 
Uninterruptable power supply or 
its battery.

Power Frequency (50/60 Hz)

IEC 61000-4-8

3 A/m Not applicable Power frequency magnetic fields 
should be at levels characteristic 
of a typical location in a typical 
commercial or hospital 
environment.

Note: UT is the a.c. mains voltage prior to application of the test level.
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Guidance and Manufacturer’s Declaration – Electromagnetic Immunity
The Nicolet EEGwireless32/64 amplifier is intended for use in the electromagnetic environment specified below. The 
customer or the user of the Nicolet EEGwireless32/64 amplifier should assure that it is used in such an environment.

Immunity test
IEC 60601 test 

level
Compliance 

level Electromagnetic environment – guidance

Conducted RF

IEC 61000-4-6

Radiated RF

IEC 61000-4-3

3 Vrms 150 kHz 
to 80 MHz

3 V/m 80 MHz 
to 2.5 GHz

3V

3 V/m

Portable and mobile RF communications equipment should be 
used no closer to any part of the Nicolet EEGwireless32/64 
amplifier, including cables, than the recommended separation 
distance calculated from the equation applicable to the 
frequency of the transmitter.

Recommended separation distance

d = 1.17 

d = 1.17   80 MHz to 800 MHz

d = 2.23   800 MHz to 2.5 GHz

where P is the maximum output power rating of the transmitter 
in watts (W) according to the transmitter manufacturer and d is 
the recommended separation distance in meters (m)

Field Strengthens from fixed RF transmitters, as determined by 
an electromagnetic site survey, (a* on the next page) should be 
less than the compliance level in each frequency range. (b* on 
the next page)

Interference may occur in the vicinity of equipment marked 
with the following symbol:

Note 1: At 80 MHz and 800 MHz, the higher frequency range applies.

Note 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and 
reflection from structures, objects and people.
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Electromagnetic Compatibility (EMC)
(a*) Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile 
radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically with accuracy. To 
assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey should be considered.   
If the measured field strength in the location in which the Nicolet EEGwireless32/64 amplifier is used exceeds the 
applicable RF compliance level above, the Nicolet EEGwireless32/64 amplifier should be observed to verify normal 
operation. If abnormal performance is observed, additional measures may be necessary, such as re-orienting or relocating 
the Nicolet EEGwireless32/64 amplifier.

(b*) Over the frequency range 150 kHz to 80 MHz, field strengths should be less than [3] V/m.
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11 Error Codes
This chapter contains error codes that may appear while operating the Nicolet 
EEGwireless32/64 Amplifier.
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Error Codes
Error codes
If an error occurs, the Nicolet EEGwireless32/64 amplifier alternates between flashing on all eight of the LEDs 
followed by flashing the error code LEDs. Table 1 on the next page identifies the corresponding error codes.

If an error occurs:

1. Turn power off to the Nicolet EEGwireless32/64 amplifier.

2. Turn power on again to Nicolet EEGwireless32/64 amplifier.
3. If the error has been corrected, the LEDs will stop flashing. If the error can not be corrected, please contact 

Natus Neurology Incorporated Technical support at 1-800-356-0007, 608 829-8500 or at 
madison.helpdesk@natus.com.

NOTE: Additionally, there is a wireless audit log that tracks information about communication with the 
amplifier. To access the audit log in the Reader application, select Tools > Create Report, and then from the 
report types, select Wireless Audit Log.
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Power LED color codes
The function of the power LED colors has been extended to aid in diagnosing internal 
battery status.

 a. Amplifier has external power source, internal batteries are charged, 
temperatures are within set limits.
• Green LED with short flash off every 5 seconds.

 b. Amplifier has external power source, internal batteries are charging. 
Temperatures are within set limits.
•Green LED with short yellow LED flash every 5 seconds.

 c. Amplifier is operating on internal batteries only. Temperatures are within set 
limits.
• Yellow LED with short flash off every 5 seconds.

 d. Amplifier has external power, the internal batteries are low and NOT 
charging. Temperatures are within set limits.
• Power LED is solid yellow, no flashing.

 e.  Amp has external power, the internal battery temperature exceed set limits.

The amplifier may still be used safely, but the internal batteries will not 
charge until the amplifier cools down.  The amplifier will shut down safely 
when the internal batteries are depleted. The internal batteries will NOT 
charge until the amplifier temperatures fall under the set limits
• Yellow LED with short green LED flash every 5 seconds.
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Error Codes
 Figure 1

Error
Number

LED error code 
displayed on 

amplifier Description
1 The FPGA or logic chip did not load correctly. An amplifier power cycle will normally fix 

this problem. If the error remains, try reprogramming the FPGA with configuration utility.

2 The MAC address of both the wired and wireless Ethernet interface has been reset to 
defaults. Try cycling power. If the error remains, contact Natus Neurology Incorporated 
Customer Service

3 The internal battery voltage is too low to provide adequate reserve power for 50 20 10 5 2 
normal operation. The amplifier needs time to charge the internal batteries. Connect the 
amplifier to power for 15-30 mins.

4 Error trying to allocate memory for the TCP connection. An amplifier power cycle will 
normally fix this problem. If the error remains, contact Natus Neurology Incorporated 
Customer Service.

5 Error trying to allocate memory for the UDP connection. An amplifier power cycle will 
normally fix this problem. If the error remains, contact Natus Neurology Incorporated 
Customer Service.

6 The internal SD card (on board memory) has not been detected. The SD card has come 
loose or is not operational. Try cycling the power. If the error remains, contact Natus 
Neurology Incorporated Customer Service.

7 The MAC address of both the wireless Ethernet interface has been reset to defaults. Try 
cycling power. If the error remains, contact Natus Neurology Incorporated Customer 
Service.

8 The MAC address of both the wired Ethernet interface has been reset to defaults. Try 
cycling power. If the error remains, contact Natus Neurology Incorporated Customer 
Service.

9 The internal batteries are missing, backwards, or the battery charge is too low. Try cycling 
the power or charge the amplifier. If the error remains, contact Natus Neurology 
Incorporated Customer Service.
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10 There is no headbox attached to the amplifier. The amplifier cannot be operated without a 
headbox attached. Attach a headbox and cycle power to remove the error condition.

11 A CPU error has occurred. Try cycling the power. If the error remains, contact Natus 
Neurology Incorporated Customer Support.

12 The watchdog reset has been tripped. Try cycling the power. If the error remains, contact 
Natus Neurology Incorporated Customer Support.

13 A brownout condition has been detected. Try replacing the power supply (AC brick) or 
external battery pack. If the error remains, contact Natus Neurology Incorporated 
Customer Support. 

14 A power-on reset has occurred. Try cycling the power. If the error remains, contact Natus 
Neurology Incorporated Customer Support. 

15 A JTAG reset has occurred. Try cycling the power. If the error remains, contact Natus 
Neurology Incorporated Customer Support. 

16 A reset external to the CPU has occurred. Try cycling the power. If the error remains, 
contact Natus Neurology Incorporated Customer Support.

17 An over-temperature condition has been detected. Allow the amplifier to cool off. If the 
error remains, contact Natus Neurology Incorporated Customer Support. 

18 Internal batteries are not charging. Try power-cycling the amplifier several times if 
necessary. Replacement of the internal batteries may be required.

19 Internal batteries over temperature. Allow the amplifier to cool off. Remove any coverings 
such as a blanket, etc.

20 Amp initialization error. Try power-cycling the amplifier. If the condition continues, 
contact Natus Neurology Incorporated Customer Support.

Error
Number

LED error code 
displayed on 

amplifier Description
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21 Amp power - internal DC voltage. Contact Natus Neurology Incorporated Customer 
Support to report this condition.

22 Incompatible firmware versions. 

When combined, AVR Firmware version 1.0.77, Gas Gauge Image version 0.1.6, and 
FPGA Firmware version 1.0.8 and higher are compatible.

When combined, AVR Firmware version 1.0.76, Gas Gauge Image version 0.1.5, and 
FPGA Firmware version 1.0.7 and lower are compatible.

Error
Number

LED error code 
displayed on 

amplifier Description
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12 Frequently Asked Questions (FAQ)
This chapter contains frequently asked questions concerning the Nicolet 
EEGwireless32/64 Amplifier.
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Frequently Asked Questions
Question 1: Why can't I select my amplifier from the amplifier selection 
screen?

There are a number of reasons why you may not be able to select an amplifier. The 
problem is typically indicated in the "Amplifier Details" box at the bottom of the 
Wireless Amp selection screen.

Problem: The amplifier is associated with a different computer.

Solution: 

You can either delete the current data off the amplifier using the computer with which  
you started the initial recording, or use the amplifier configuration utility to break the 
association.

1. Connect the amplifier via the micro USB cable to a computer that has the 
configuration utility installed.  

2. Double-click the Nicolet Wireless Configuration Utility icon on the desktop.  

3. Go to Tools and select Clear association. 

4. Close the window.  The amplifier is now be ready for data acquisition.
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Problem: The amplifier either has an incompatible headbox type (a 64 channel headbox on a 32 
channel amplifier) or there is no headbox attached to the amplifier. This is indicated 
in the Amplifier Details.

Solution: 

Connect a compatible headbox to the amplifier. If the amplifier is a 32 channel 
amplifier, the only compatible headboxes are a 32 channel or w10-20HB headbox.

Problem: The last used protocol does not match the required protocol (i.e., using a 32 channel  
amplifier, you must have a 32 channel or w10-20HB protocol selected). This is 
indicated in the Amplifier Details.

Solution: 

You must select Cancel from the amplifier selection screen. When you are presented 
with the recorder screen, select the proper protocol from the protocol menu. After 
selecting this protocol, exit NicoletOne recorder and then launch NicoletOne recorder 
again.

Problem: The amplifier went out of range or was disconnected after the Amplifier Selection 
window was opened.  The intended amplifier will not be listed.

Solution: 

Connect the amplifier either by bringing it back into wireless range or by tethering the 
amplifier with a ethernet cable.
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Frequently Asked Questions
Problem: The data on the amplifier was recorded with a different headbox type (only happens 
on 64 channel amplifier). The amplifier details indicates this.

Solution: 

Connect the correct headbox type to the amplifier to retrieve the data. If you have a 64 
channel headbox connected, connect a 32 channel or w10-20HB headbox. If you have 
a 32 channel headbox connected, connect a 64 channel headbox.

Problem: The bipolars selected in the current protocol do not match the bipolars selected on the 
amplifier. This is indicated by a dialogue box that appears after the amplifier has been 
selected.

Solution: 

Follow the instructions in the dialogue box by changing the appropriate channels to or 
from bipolar in the protocol (Note: If this happens frequently, change the default 
bipolar settings in the configuration utility.)

Problem: The current protocol’s sampling rate is over 4096Hz and the amplifier is connected 
wirelessly.

Solution: 

Connect the amplifier to the network with an Ethernet cable or cancel the selection 
screen and choose a protocol with a sampling rate that can be used wirelessly.

Selecting a new protocol with a sample rate that is over 4096 Hz and the amplifier is 
in the Wireless mode will result in the amplifier not listed in the Amplifier Selection 
screen.  By design the amplifier will only work in the Wireless mode with sample 
rates less than or equal to 4096 HZ.
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Question 2: What happens if I try and review an exam that is incomplete?
If you are in NicVue and you attempt to open an exam that is marked "NicoletOne" in 
the "Exam" column, two situations can occur depending on the status of the amplifier. 

If the amplifier is disconnected from the network, you are prompted to connect the 
amplifier and retry. If you select Cancel, you will be able to review only the data that 
has been currently downloaded.

If the amplifier is connected to the network, you are prompted to either download the 
remaining data and merge the files, or mark the exam as complete and review only the 
data that has been currently downloaded.

Downloading an exam from the Amplifier requires that the exam not be open for 
review on any other PC's.

Question 3: How do I know if an exam has been completely downloaded 
by looking in NicVue?

In NicVue there is a column labeled "Exam". If the entry in this column for your 
exam is "NicoletOne", that is an incomplete exam.

Question 4: Why does a single exam have multiple exam files?

When you have an incomplete exam in NicVue and you then download the remainder 
of the exam (either through Reader or Recorder), a second exam will appear, which 
will be marked as complete (i.e., Not have an "Exam" of NicoletOne).

Once the exam has finished and all file catchups are complete, the complete exam file 
will be marked nEEG, nLTM, nSleep, vEEG, or Monitor with a title of 
"DOWNLOADED" and have the most recent time stamp.
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Question 5: What is an "overflow error"?
Sometimes, when the amplifier is communicating with the Nicolet software, a 
miscommunication occurs, which inserts an "overflow" event into the log. When this 
happens, you may see a large artifact appear for up to 10 seconds. If this happens 
frequently, please contact customer support.

Customer Support: 608 829-2040 or madison.helpdesk@natus.com

Question 6: What if my memory card fills up and I am still recording?
During LTM studies your memory card may fill up completely while you are still 
conducting the study. When this happens, 

NOTE: The recording LED will start to blink and amplifier will beep prior to this 
happening.

1. Stop the study.

2. Close NicoletOne.

3. Reopen acquisition with the same amplifier. 

4. When prompted, clear the onboard memory (provided you are sure that you have 
all the exam information) and begin a new exam.

NOTE: If you select Retrieve Data when entering acquisition, Nicolet will 
download the entire exam, which will erase any annotations in the current exam. 
Open the exam in Reader if there is information that has not been downloaded.
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